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Introduction

Whether you gather customers around a conference table or sit down for a one-on-one, bring Morae along to
capture the interaction and share the results quickly and powerfully.

Type notes and flag important moments as Morae records video from up to two cameras. Team members or
stakeholders can watch the |Iive video stream..and | og t|
on your hard drive—no videotape to transfer, no hand-written notes to type up.

As soon as the session is over, quickly search back through the notes and markers, select the best clips, and
export your highlight reel directly to PowerPoint. Faster turnaround—better results!

For focus groups, Morae can record from one or two cameras. With two cameras, you can record a wide
angle of the complete focus group, along with close up camera video of specific participants.

This document provides the following:
# Focus Group Basics
Set Up the Focus Group

[
# Record and Log Focus Group Sessions
# Analyze and Present Findings

The document also contains Appendix A: Focus Group Summary Outline, which you can use as a
template to put together a Summary Report.
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Focus Group Basics

Focus group research helps you gain deeper understanding of attitudes and beliefs of representative groups

of people - often customers or prospective customers - by asking them to have a conversation about your

product Focus groups help researchers and marketers gain
needs, develop additional research tools, and make truly informed decisions on the design of products and

services.

Focus groups start with a proposal or work statement that defines:

Research goals

Strategy

Research methodology (how many focus groups, how many participants, where and when)
Research methods to be used (conversation, simulation games, direct product contact, etc.)
Sampling methods and participant qualifiers

Incentives you plan to provide for participation

¥ ¥ ¥ ¥ ¥V ¥V ¥

How your findings will be analyzed and delivered

Recruit Participants

To recruit focus group participants, you may find it helpful to use client lists, internal databases, or email
contacts. You might use a Web ad or use a professional recruiting agency to assemble an appropriate sample.
An effective focus group sample has a maximum of ten participants.

# Create a screening device to help you recruit the right sample. You want to reflect your target population
as close as possible. You may be looking for a particular age, gender, type of consumer, or other
qualification.

B  As you schedule your groups, you may wish to segment your groups by demographics (age, gender,
education, etc.), types (power users and new users, Ford or Chevy owners, etc.) or mix them, depending
on your research objectives.

B As your recruits agree to participate, send them a letter and/or an email with the specifics of location, time,
and date. Include a map and give them a phone number to reach you.

Morae Configuration

You can use Morae to capture your focus group sessions. The Focus Group template in Morae Recorder
includes all of your markers and camera settings needed, and you can tweak the template with your own
settings. Remember to think about camera angle, microphones and lighting. A trial run will help you identify
problems and get everything ready.

Create a moderator's guide for each focus group session. Include open-ended questions designed to
stimulate conversation and to keep the conversation flowing smoothly. The questions should help you gain
gualitative data for your research objectives: Key words and phrases for additional survey research.

If you use an observer to help you take notes, give the observer a copy of the guide and discuss in advance
what you would like the observer to note, including interesting quotes or moments of conversation.
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Conduct the Focus Group

Set up your camera(s), recording equipment, and any additional props or tools you might need during the
conversation. Seat participants and ask them to sign an agreement to be recorded, and make sure they are
comfortable.

The moderator asks questions and writes notes on white board/paperto captureever yone' s commen
guide the conversation. The moderator may also take notes in the moderator guide. The observer should

make notes using markers in Morae to flag reactions, emotions, and interaction with the product and among
participants.

Tips for great focus groups:

Give the group a warm up exercise to get to know each other.

# Reviews basic instructions and your goals.
#  Keep everyone talking; avoid letting one person dominate.
B Use the reflection technique to clarify statements and to further stimulate the conversation and flow of

ideas:—wWh at | hear you saying is.. Il And —so, what you
# Remember to thank your participants and provide them with their incentive when they leave.

Take Notes

Your observers can be a key to capturing great video. The observers log notes from any location on the
network using Morae Observer, or can simply make notes on a laptop using moderator's guide as a script.

The observers type as much detail as possible. In Observer, use a predefined Quote marker to note the spot
where a participant makes a particularly good statement.

Your observers may note that recurring messages or themes. Ask your observer to categorize themes or
trends as they become apparent. The moderator can make notes that can be tagged with a marker.

Debrief

Attheendofthe day, ask your staff and stakehol ders #Ask meet
your clients - what did they see, what were the surprises, what else needs to be explored?
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Report Findings

There are several ways you may want to present your findings:

g

Top line report
@ High level bullet report — you don't need much detail.
@ [dentify trends, themes and answers to the objectives of the research.
@ |dentify surprises or unexpected comments.
Comprehensive summary report
@ Review the material in more depth.
@ |nclude specifics and detalil.

# Objectives

# Goals

# Table of participant segments

# Your script and the incentives offered
Presentations
Other deliverables, such as DVD recordings of full sessions
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Set Up the Focus Group

Use the steps in this section to set up the study in Morae Recorder for a focus group. For more information on
focus group planning, see Focus Group Basics.

Morae
Recorder

To set up a test in Recorder:

1. Create a Study Configuration
2. Define Questions

3. Define Markers

4. Save Study Details

5. Configure Recording Details
6. Complete Focus Group Set Up

A’ This document walks through this process at a high level. You can find more information on the full
procedures and options in the help included in the Morae components or find both video and written
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.
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1. Create a Study Configuration

A study is a group of focus groups that discuss the same topics. In Morae, a study configuration file (.mrcfg)
defines all study-specific information. This includes the tasks (questions) and markers.

Use the same study configuration to record each of the focus group sessions. Only recordings with the same
study configuration can be later searched and graphed together in Morae Manager.

Morae Recorder includes template study configurations to help you define study configurations for different
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured
Recording Details which define how to record the session.

When you open Recorder, create a new study configuration based on Focus Groups. When you click OK,
the template study configuration opens in Recorder.

Welcome to Morae Recorder @

To record, you must create or open a study configuration,

Study configuration

The study configuration defines the markers, tasks, and surveys
for your study.

D {(3) Create a new study configuration based on:
v

Hardware or Mobile Device Study
Paper Prototype Study
. : Software or Web Usability Study
D (OlUnmoderated Usability Study

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study
Description > Study Instructions.

2. Define Questions

For a focus group, you define the questions you plan to ask during a session as tasks.

Tasks in Morae Configuration
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Recorder > Modify Study Details button > Task Definitions tab

For each question, enter a name and description.

Study Details

| Description | Task Definitions | Marker Definitions || Survey Definitions |

Define tasks to log during sessions.

MName Description Instructions ‘ A
Please tell us about your experience with online 5., |Mone [iie
Question 2 Can vou tell us about a time that you were happy... Mone
Question 3 & Can vou tell us about a time that yvou were unhap... None =

Task (question) names, descriptions, and ==

scores are available to the task logger and in
the task information in Manager. —

Success score

; Use the task success scores to rate the level of
Success score applies to all

feedback you receivefor each question.
Definition You can create a task success score graph in
Manager to automatically calculate and visually

Limited feedback 5 .. 4
Good Feedbackjdiscussion display the feedback levels.
Surprising feedback/discussion z2

A  Remove |

[V] Start Scale with zero {0)

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks.

3. Define Markers

After you create questions (tasks), then create the markers. Markers allow the observers to flag specific,
important points in a recording and save time when you analyze the results.

For example, mark:

B Participant comments and questions
B Observations about how the participants react
B Interesting comments or actions to include in a highlight video

You can also add notes to provide additional details for each marker. All the markers and notes are
synchronized with the video and saved in the recording of each test session.

Morae also includes the ability to score markers, for example 0 (negative) and 1 (positive).
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Markers in Morae Configuration

d Recorder > Modify Study Details button > Marker Definitions tab

In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and color.
Each study configuration template includes a default set of markers. The Focus Group template includes the
following markers:

’ Q - Quote ® N- Note

Use the provided default markers, modify the markers, or create new markers that match the goals of your
study or identify specific things you want observers to watch for during a session.

Morae Marker Tips

#  There is no correct number of markers. The object of logging markers during a focus group is to make it
easier to analyze the results.

B  If you have specific things you want to look for in a test, create a marker for that item, comment, issue, etc.

B Later when you analyze your sessions in Manager, markers help you sift through data and focus on what
you want to analyze. For example, viewing all the Quote markers with negative scores may reveal where
people are unhappy with a concept.

#  When you are ready to create video clips or a presentation for stakeholders, you save time by quickly
going to the moments during the session that you marked as Quotes to include in the highlight video.

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers.

4. Save Study Details

LJ File > Save Study Configuration or click the Save Configuration icon.

Study Details must be the same for all recordings in a study and include:

B  Study name and description
B Tasks definitions
P Marker definitions

By saving the study configuration, and reusing that configuration, all recordings have the same configuration
and can be imported into the same study in Manager.

5. Configure Recording Details

Recording Details included in Morae study configurations define how to record the session, including the
following:

B File saving and processing options

Video sources

What data to capture

Who logs tasks

How to start and end test recordings

¥y ¥ V¥
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Recording Details in Morae Configuration

&8 Recorder > Recording Details button

The Recording Details of the template study configuration allow you to immediately conduct a recording. The
Recording Details for the Focus Group template include:

#  Prompt for file saving details when recording stops

Record from a camera and optionally include a Picture-in-Picture video from a second camera

Log tasks with the computer running Recorder (Local Logger)

Start and stop recordings manually with Recorder

Allow Observers

¥y ¥V ¥V V¥

Morae Recording Details Tips

# Recorder automatically chooses the source cameras for the main and PiP videos. Verify the selected
sources are correct before recording.

# If you change any Recording Details settings, the rest of the settings update to provide a valid or
recommended configuration, if needed.

# Recording Details are saved as part of the study configuration. While the Study Details must be the same
for all recordings in a study, the Recording Details can vary in each recording.

For more information, in the Morae Recorder Help, see Define Recording Details.

6. Complete Focus Group Set Up

Study configuration is now complete. Here are the final things to do before you start recording.

B CreateModer atoro6s Gui de
# Finalize Morae Recorder Setup

CreateModer at or s Gui de

Themo d er at o risaslocygnert af everything the moderator needs to know for a focus group. The
facilitator can use this document as a script during the session. Some of the items to include in the guide
include:

B Introduction

B Guidelines for the session

@  How long the session will take

@ The topic (product, idea, etc.) of the focus group

@ All opinions are welcome

Explain the Release Form and have participants sigh agreements

Ice breaker for group

Discussion questions

Closing and thank you

¥y ¥V ¥V V¥
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Release Form

A release form gives permission to record the test. Morae records the video and audio of the participants.

If permission to record is denied, you may still conduct the focus group and take notes to use in reporting
results, but you must not record the session.

If the contents of your test require the participant to keep session and product information confidential, include
a non-disclosure agreement in your form.

The example test protocol includes a sample release form that includes a non-disclosure agreement.

Email Invitations for Observers

Verify that all observers have Morae Observer installed. Send an email to each observer with the following
information:

g

[
[
[

Name of focus group

Date of focus group session

Time of focus group session

IP address or name of Recorder computer

You may also want to include a list of the questions and markers to let the observers understand what
they should watch for during the session.
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Finalize Morae Recorder Setup

Prior to a Morae test, complete the following tasks:

B Complete the Pre-recording Checklist
# Run a Pilot Test before Recording

Complete the Pre-recording Checklist

The following checklist describes critical points that reduce the technical issues you may encounter and
improve Mo r a evérall performance.

Step

Verify the system
requirements

Description

Verify your system meets the recommended specifications to get the most efficient

performance from Morae. For more information, see Morae System Requirements
in the Morae Recorder Help.

Verify you have
enough hard drive
space

Recording file sizes may be approximately 10—-15 MB per minute, but the actual size
varies depending on many factors. You should have extra space available for the
best performance during recording.

As a general rule, maintain 5-10 GB of extra hard drive space as a buffer beyond
what your Morae recording files use.

‘; We recommend initially saving your recordings to a local hard drive to eliminate
the chance of data loss that can occur when saving over a network or to an
external device. After the file is saved, you can copy the recording file to an
external device.

Test your setup

Test your setup before the actual recording session to resolve any possible
complications (such as firewalls blocking Observer(s) from connecting, etc.).

We recommend running a pilot recording
start and stop options and to verify Observer(s) can connect. For more information,
see Run a Pilot Test before Recording.

A’ In addition, use the Test Recording option in Recorder to create a 15 second
recording to verify the camera and audio streams are being recorded properly.

Verify Network
Settings

If Observer and Recorder are on the same Intranet, you do not need to disable
firewalls.

If they are not, verify that you either disabled any firewalls running on the Recorder
or configured the firewalls to open the communication ports. See your network
administrator for assistance.

There are no firewall adjustments necessary on the Observer side.

Open the study
configuration in
Recorder

Open the saved study configuration in Recorder.
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Run a Pilot Test before Recording

We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot
recording helps you work out any network connectivity issues and test your automated start and stop options,
if applicable. Follow these steps to run a pilot test:

Step ‘ Notes
1. Open a study configuration. In Recorder, open the study configuration (.mrcfg) for this study.
Start Recorder. Click the Start button to start Recorder manually.

3. Connect Observers to Recorder. | Connect one or more Observers during the pilot test. Verify that you
can successfully connect each to Recorder.

4. Complete a test task. Run through one of the tasks. To test the logging functionality of
Observer, have a team member practice setting markers while you
complete the task.

5. Stop Recorder. Either stop Recorder manually by clicking the Stop button in
Recorder or use the keyboard shortcut <Ctrl + Alt + Shift + F9>.
6. Import the recording and run a Save the test recording file and import it into a project in Manager. In
search. Manager, verify the audio and video recorded correctly. Use the

Search to verify markers were captured. See Analyze and Present
Findings for more information on how to do this.

Page 14




Record and Log Focus Group
Sessions

In this section, we discuss how to record and log test sessions using Morae Recorder and Observer:

# Observers and Logging

#  Start and Stop the Recording
P Logthe Sessions

# Save the Recording

Take Notes on Recorder

When you record from one or two cameras with Recorder, you can log questions and notes right on the
computer running Recorder. This is the default task logger setting for camera only recordings.

Observers and Logging

Morae Observer connects to Recorder over a network and displays the full focus group experience, including
audio comments and camera video. Each person using Observer can log markers, marker scores, and text
notes that are sent back to the Recorder and saved with the recording file.

By logging questions, markers, and notes during the test session, you save time analyzing the recordings. In
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically
create graphs, calculate marker scores, and more.

Observers can connect prior to the beginning a recording, as long as Recorder is running. Observers do not
see the camera video until recording begins.

Benefits of Observer

Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the
following benefits:

B Stakeholders can connect to watch live sessions without the need be in the room with the focus group or
an observation room. With Observer, stakeholders can connect from anywhere on the network.
#  Anyone logged into an Observer computer can add markers during recording complete with text notes.

@ Morae automatically collects and compil es everyone’'s notes. The recordi
notes logged by all Observers.

@ Observer automatically saves and indexes the markers and tasks with the accompanying video and
audio streams.

B You can save a copy of the camera video and audio streams as a WMV file for immediate playback or to
share with stakeholders.

For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to
Recorder.
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Start and Stop the Recording

The default way to start and stop recordings is to click the following buttons:

@

Start Stop

If this does not meet your needs, Morae provides flexible options to automatically start Recorder depending
on your equipment and participant set up.

For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start
Settings and Define Recording Details > Recording Stop Settings.

Log the Sessions

Once recording starts, the moderator starts asking the questions.

The person working on the computer running Recorder along with each person using Observer can log
markers, marker scores, and add text notes to save with the recording file. The person working on Recorder
is designated as the task logger logs questions and scores.

With both Recorder and Observer, you can save a copy of your markers and notes as a comma separated
values (CSV) file to import into other programs. Observers can also save a copy of the recording as a WMV
file for immediate viewing.

At the end of a session, the questions and scores are saved with the recording. You can view the
synchronized video, audio, and notes for each marker later when you import the recording into Manager.

By logging with Recorder and Observer during recording, you will save time analyzing the study in Manager.
There should be no need to review entire recordings
features to quickly analyze the recordings.
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The components used when logging in Recorder and Observer are:

Marker Definitions
Click a Marker Type to
:"‘*"*"‘ " enter a marker. (Optional)
< -

Type  Defrtion
®o e
X Emor
. M Lo neads telp
& 0 Ctoeersen
&P Patcpyk provgted

&y wede
Survey: Survey [in progress) |A7H:ull ]
Mot Marker |
D ruseiin | |@ edranig ] ° . e
Log &5 Task4 v @ 1¥eths product! Quckafcomrent

00:01:18 5= "
. . ]6_-:1-.6 | LOQ

Log markers and take notes. Log
[Rscordng e = 00.07.45 task start and end, if applicable.

ca

Score

L

View session main

Viewing Window

meravideo and PiP
video, ifincluded.

Task Trve
Task | D055
Task 1 00603
Task 1 00622
Task ¢ 00626
Task 4 00703

g Connection 9 Recordng

For more information, in Morae Observer Help, see Log a Session.

Save the Recording

By default, when recording stops, you are prompted for file details. Enter a name and description for the
recording. If you want to start another recording right away, in Recording Details, choose to defer the

processing of the recording. You can later batch process recordings.

For additional options, in the Morae Recorder Help, see Define Recording Details > File Details >

Processing.

V' You cannot save a recording without a name. You can lose the data from a recording if the test
participant, or anyone else, closes the dialog prompting for these details after the recording stops.
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Analyze and Present Findings

In this section, we discuss how use Morae Manager to analyze your recordings and create a presentation or
report of your findings:

1. Import Recordings
2. Edit Recordings

3. Analyze Recordings
4. Create Highlight Clips

5. Create a Summary Report

1. Import Recordings

To import recordings into Morae Manager, first create a Morae project. Use a project to organize the
recordings and studies in Manager.

You can import a single recording into multiple projects. When you import a recording into a project, the
original recording is not touched. A copy of the recording in imported into the project. Any changes you make
to this copy do not affect the original recording.

You can import Morae recording (.rdg), UserVue recording (.rdg) and standard video files (.avi, .wmv, .asf)
into a project.

For more information on importing recordings and creating projects, in the Morae Manager Help, see Create
and Modify a Project > Create a New Project.

2. Edit Recordings

View and edit the imported recordings in the Analyze Tab. In Manager:

B+ Review the main camera video automatically synchronized with the Picture-in-Picture video and audio.
# Create additional or edit the logged questions, markers, notes, and scores.
B Search across recordings in a study for specific markers.

For information, in the Morae Manager Help, see Analyze.
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3. Analyze Recordings

Manager’ Search allows you to quickly create custom searches to look for markers and tasks. Use the pre-

defined search profiles, define a new search, or create and save your own search profiles.

Search for markers that meet the following criteria,

§e&thfov: .
[] screen Text ‘
l'_']wr\dowloidoqivet*s
[¥] Markers (Specific markers of mark. ..
[[] Mouse Clcks
[7) uservue Chat
[[] Keystrokes
[[] web Page Changes
In all applcations
O all markers
(®) Speciic markers
[“]Marker type
[] E-endtask
[] N-Note
¥ Q- Quote
[] 5-start task
[ (generic)
Oa
g 3
<
[ marker score

Click to change the search.

[ selectan |
|C|aaAll

' Click to save the current search as
a profile.

Ve.opp. Question 2 Marker  Q(Quote)

-

<

- Seatch profile -

Custom search
| Elapsed Time  Recording 7/ Task Event Detais Score
0:00:46.15 Onlne Shoppi... Question 1 Marker Q (Quote) Score not set
0:01:05.97 Onlne Shoppi... Question 1 Marker Q (Quote) Score not set
0:01:34.93 Online Shoppi... Question 1 Marker Q (Quote) Score not set
0:01:54.15 Onle Shoppi... Question 1 Marker Q (Quote) Score not set
0:00:39.54 Onlee Shoppi... Question 1 Marker Q (Quote) Score not set
10:03:00,75 Online Shoppi... Question 2 Marker Q (Quote) Score not set
0:03:38.52 Online Shoppi... Question 2 Marker Q (Quote) Score not set
'0;04:21,50 Shoppi... Question 2 Marker  Q(Quote) Score not set
10:04:57.27 g? Score nok set

;&;m Results include all occurances | suiecred buration: Not appicable
from all recordings in the study.

For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings.
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4. Create Highlight Clips

When you are ready to organize the results of your analysis into a highlight video for presentation, select
Manager’ Present tab. Use the Clip Bin and Storyboard to create, view, edit, and sort clips and graphs and
assemble them into a video presentation.

In the Present tab, assemble the important video clips, graphs and tasks into a highlight video to share with

stakehol der s. I nclude just the participant’ sin-Bictureeen an:
(PiP) window showing theparti ci pant ' s f aci al e x proeabdapmdusedin AW &MW,i ghl i g
or MPEG-4 format.
Project Pane ClipBin
'Organize studies Store and organize
and recordings. video clips, graphs, : <
\ _ and title clips from & B Player Window
. the project. Present Tab Toolbar View the scrgen
e Ek Costs x| - \, ‘and camera video,
i\ a . EJ ﬁjm&xw:mwamavmmr « | including the PiP.
‘\ i -
Presast - Pramct o Rmﬁg-rotwm"
| Exarpls Projct Foous Group -~ L——— . - /
-'I‘Slrus CloName  Rocordng  Dusbon &
+ % Markars Vidoo Clips !
= U e e A
mw Aremals Pocusar, ..  0:00:13.31
mr-,-luq--lxn;d. Food Deive FocusGe... 0:00:4219
“a‘m.th Goo qura .. Patipa. 0:00:4054
Presemt Refugee Nat.,,  Focusar 0;00:43.01
&4 Food Drive Schook Focusar..,  0:00:17.0%
S Aok Qi Ten Com... Participa.. 0:00:2351
5"‘4;’;’ — Thee Emores Particpa...  0:01:21.41
bve a0 we Foous - 3 00 17.43
: E'n Exangle Project Paper Protol :m;z ::':v?. i g:cmu;:‘»; :;
Particpant |_Paper »
< » Tle Clips
Detads - ideo Clo By the Nund.. 0:00:02.00
T Exarmples Pro.. 0:00:02.00
lCl o frad 0;00:02.00
Tast Notes: Good Things 0:00:02.00
None> How do you . 0:00:02.00
Some Cbser,, 0:00:02.00
Norre! Thank youl 0:00:02.00 “
Food Orive .
Image Clps |
e ( , ¥ Dot -k VO
T By Test reornonts onmeeing e GiouR SIS el Timeline
| B = Navigate through

Details Pane
View details about
the selected item.

S S~

Sto

ryboard

Assemble and produce
highlight videos.

. recordings, tasks,
markers, and clips.

NM
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After you have your highlight clips together in the storyboard, click the Produce Highlight Video button and
select the Produce to PowerPoint option to produce the videos and send them into a PowerPoint
presentation.

A Example Project.mpr - Morae Manager

File Edit Create Play View Help

H 9«

Production Wizard

Welcome to the Morae Production Wizard! .
Select one of the ways in which to produce your highlight video, © i\\,) )
) s

Production Type

O Produce to file .
Produces the highlight video and saves it to disk. Vs

(%) Produce to PowerPoint

Produces the highlight video and exports it to PowerPoint.,
You must have Microsoft PowerPoint installed.

For more information on creating highlight clips and options for exporting other data from Manager, in the
Morae Manager Help, see Present.

5. Create a Summary Report

Appendix A is an example outline for a Focus Group Summary Report. Use this outline to help structure your
results from the focus group sessions.
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Appendix A: Focus Group Summary
Outline

Title of project:
Prepared by:

Date:

Executive Summary

At the request of (Name of Client), (Name of Company) conducted X focus groups between (dates) to explore
(state the subject matter.) The purpose of this inquiry is (state purpose). The inquiry was focused on (state in
general terms who participated) and is intended for (state the persons to whom this is directed.)

Findings show (summarize findings, themes and observations)

Introduction

(Introduce the subject, the client, the environment and the objectives of the research.)

Methodology

State the specifics:

#  Who performed the research

#  Who was researched (how many of what types of participants)
#  How participants were recruited and selected

#  When, how and where the research was conducted

Findings
B State the overall findings, followed by specifics.
B Include participant quotes (or links to video)

Analysis and Recommendations

Item 1 found through analysis
Recommendation 1

Item 2 found through analysis
Recommendations 2

¥y ¥ ¥V VW%
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Action Items

B Action ltem 1
#  Action Iltem 2

Other Considerations

B Consideration 1
# Consideration 2
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Appendix B: Example Focus Group
Moderator Guide

[. INTRODUCTION
1. My name is _ _ 7 moderatortoday.and | ' m t he
2. The purpose of this discussi on i s to talk about _ __ . [ I
experiences.
3. I am an independent market research consultant. I
have anything to sell. | travel all over the country and talk to people like you about products, services
and ideas.

[I. GROUND RULES

1. This session will last about 1% hours.
2. This session is being audio taped and after the fir
3. Observers are present. Notes may be sent in.
4, There are no wrong answers in marketing research; we are looking for different points of view. | want

to know what your opinions are.
5. Everyone needs to talk but each person doesn’t have
6. Please talk one at a time and in a clear voice, avoid side conversations. It is distracting to the group

and I don’t want to miss any of your comments.
7. Exchange points of view with eachother—-y ou don’t need to address all an
8. Does anyone have any questions before we begin?

9. This is a non-smoking session.
10. Please turn off all cell phones and pagers.

[ll. BACKGROUND (5 minutes)

1. Please take the first few minutes to get to know the person seated next to you.

2. Il °’m going to ask you to introduce him/her to the gr
person such as their interests and hobbies, if they have a family, and how long they have lived in the
area.

IV.Previous Experience - General (10-15 minutes)

Why did you decide to use ?

How long have you been a customer?
Do you have experience with similar products? Which ones?
Why do you have multiple products?

Has anyone switchedf r om one company’s product ? Wbatausedydur om an
to switch?

a bk wbdpeE
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V. Previous Experience- Specific (30-40 minutes)

1. How knowledgeable do you consider yourself regarding this company? What types of products do
they offer? Do they offer anything unique?

2. What is the image of this company? What reputation does it have? What are some of its
competitors? What image and reputation do they have?

3. What do you value most about being a customer?

4, Overall, how satisfied are you with the service you receive?

5. Would you recommend to others? Why or why not?

6. How loyal do you consider yourself to ? What could they do to make you
more loyal?

7. Is there anything that would encourage you to use other products from the same company? (Probe

with specific products.)

8. How many of you use the online resources available from this company? If not, why not? (Probe:
with specifics of known online resource issues.)

VI. COMMUNICATION (5 -10 minutes)
1. Where do you get information about the product?

2. How well does communicate with you?
3. What ' s the best way for ttheouzompany to communicate

VII.  ADVERTISING (20 minutes)

1. Have you seen any advertising for ? What type of advertising have you seen?
2. Review communication materials.
3. What do you like about this ad? Is there anything you dislike?
4, Is it memorable? Does it seem credible?
VIll. FALSE CLOSE (5 minutes)

Thank you for your comments and your time. This has been a valuable session. Focus groups are one
technique that assists market researchers in satisfying customer needs. Thank you again.
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